
 

GH Editorial Guide #1 

Tips for formatting your Word documents 
 

 

Do you use Microsoft Word to write reports, articles, newsletters, 
book manuscripts, or anything else that needs to have a 
professional look about it? 

Maybe you’ve got into the habit of just typing away as soon as 
you’ve created a document, without thinking much about how it’s 
formatted. Maybe you use the default Normal style for 
everything, and just make your headings bold. 

It’s tempting to work that way, especially if you’re enthusiastic or 
in a hurry. There are better ways, though. 

If you make sure the formatting is consistent, this will help your 
readers to focus on what you’ve written, without being distracted 
by variations in its appearance.  

If you make sure the formatting is logical and the different types 
of elements can easily be distinguished from each other, this will 

help your readers to understand how the content is organised, 
and to find their way around it. 

And if an editor is going to check the document, good formatting 
will help the editing process to go smoothly. The editor will be 
able to concentrate on the wording, rather than having to spend 
a lot of their time working out how it should be formatted. There 
are other advantages as well, which will be explained later in 
these pages. 

This guide will help you through the basics of how to create a 
document with a professional ‘look and feel’ – using Word’s 
main formatting functions, along with styles and templates. 

If you’ve been asked to write your document using an existing 
template, this guide isn’t really aimed at you, although you still 
might find some useful tips here.

 

Graham Hughes 

 

www.gh-ed.com   

http://www.gh-ed.com/
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Please note: The detailed advice and screenshots in this guide are 
based on the Office 365 Business version of Word at the time of 
writing (Version 1905), running on Windows 10. Some details might be 
different in your installation, but hopefully not enough to make my 
suggestions difficult to follow. 

Using styles 

The key to well-organised formatting is to use Word styles for 
everything in your document. 

This is a reliable, efficient way to keep your formatting 
consistent, and to make sure the reader can tell the different 
types of text apart from each other. 

It also makes your life easier. If you change your mind about 
how you want to format the main text, or some other type of 
element, you’ll only need to adjust the definition of the relevant 
style: your changes will be applied globally straight away. 

Types of style 

You’ll need to understand the distinction between paragraph and 
character styles. 

Paragraph styles are the type that you’re more likely to find 
useful. They define paragraph-level features of the text such as 
indentation, alignment and vertical spacing. They also have 
character-level attributes such as bold, italic and text colour – 
but you’ll need to be careful with these, making sure they’re 
applied the way you want them to be (see the note under 
‘Creating, changing and applying styles’). 

Character styles only define those features that are relevant to 
characters (bold, for example) rather than to a whole paragraph. 

There are also linked styles – these can be used at either 
paragraph or character level, depending on whether you’ve 
selected a whole paragraph or just some characters within one. 

Accessing the styles 

If the Home tab is open, you’ll see the Style Gallery towards the 
right of the toolbar, showing some of the styles available: 

 

To see all of them, click on the arrow to the bottom right of the 

Style Gallery, and the Style Pane will appear at the side: 
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Here, paragraph styles are marked with the ‘¶’ symbol, character 
styles with ‘a’, and linked styles with ‘¶a’. Each one has a drop-
down menu available, including a Modify option. 

You can control the order in which styles appear in the Style 
Gallery using the Manage Styles option, available via a button at 
the bottom of the Style Pane, as explained here. 

Creating, changing and applying styles 

You can find good advice about this on the Microsoft support 
site. 

When applying styles, be aware of how paragraph and character 
styles work differently: 

• If you select one or more complete paragraphs and apply 
a paragraph style, this won’t change any character-level 
features of the text. For example, if a word is in italics, it 
will stay in italics regardless of how that style is defined. 

• However, if you only select part of a paragraph and apply 
a paragraph style, Word will make sure all the selected 
characters follow that style – this might not always be 
what you’re hoping for. 

When you’re done … 

When you’ve finished writing, it’s worth checking that every 
piece of text – every heading, paragraph and so on – is in a 
suitable style. You could do this by just moving your cursor 
down, heading by heading and paragraph by paragraph, and 
checking that the right styles are framed in the Style Gallery or 

Style Pane. For a bit more detail and clarity, though, you might 

prefer to use the Style Inspector, available via the  button. 

To keep your formatting consistent between documents, you can 
create templates (see ‘Using templates’). 

  

https://superuser.com/questions/1222872/how-do-i-rearrange-font-styles-in-microsoft-word
https://support.office.com/en-us/article/customize-or-create-new-styles-in-word-d38d6e47-f6fc-48eb-a607-1eb120dec563#new
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Types of content 

For a fairly straightforward report, article or other document, the 
main elements you’ll need to think about are the normal text (at 
both character and paragraph levels) and headings. 

A more technical or academic document might also have 
features such as formulas, equations, captions, notes and 
references.  

Other elements also might come into play: lists, displayed 
quotations and table text, for example. 

Characters 

Choose a font type that is easy on the eye and makes 
everything clear. Make sure the text is large enough to be read 
comfortably. If the document is likely to be read on computer 
screens, don’t force the reader to lean forward or zoom in. 

If you want to use things like bold, italics and different colours, 
only do this sparingly, otherwise they can become a distraction. 
If anything is underlined, especially on a web page or in a digital 
document, readers might think there’s a hyperlink – so it’s best 
to avoid underlining unless there actually is one. 

Remember that character-level features (bold etc.) can be 
defined in both character and paragraph styles. 

Paragraphs 

Think about which paragraph layout you want to use. There are 
two basic formats: 

• Indented – the first line of each paragraph (except, 
usually, the first one after a heading) is indented from the 
left margin. 

• Spaced – there’s more vertical space between 
paragraphs than between lines in a paragraph (as in this 
guide). 

Indented paragraphing is generally better for longer items such 
as books and newspapers, whereas spacing is preferable for 
things such as web pages and reports. There’s no need to use 
both methods together – that would be overkill. 

Whichever layout you choose, don’t apply it manually, by using 
the Tab key (or, even worse, a string of spaces) to produce 
indentation, or by hitting the Return key twice at the end of each 
paragraph to create a spaced layout. 

Instead, make use of Word’s Paragraph formatting functions. 
That way, once you’ve defined your settings, Word will do the 
work for you, and you can make sure the amount of indentation 
or spacing will be consistent and just how you want it. 

To do this, open the Paragraph dialogue box and ensure that the 
Indents and Spacing tab is showing. 
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Then, for indented paragraphs, use the Indentation options as 
below. ‘First line’ means that only the first line of each paragraph 
is to be indented: 

 

If you don’t want the first paragraph after each heading to have 
its first line indented, you could create another style, where 
Special is specified as ‘(none)’ rather than ‘First line’.

For spaced paragraphs, instead of using the Indentation 
options, fill in the Spacing options with details such as those 
below: 
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To put more space between lines within a paragraph, use 
something other than ‘Single’ for Line spacing, and, if needed, 
specify more detail under At:  

 

Also think about the horizontal alignment of the text. In books 
and newspapers, it’s usually fully justified: in other words, every 
line goes all the way to the right margin (except for the last line 
in a paragraph, unless it happens to be long enough to reach 

that far). This gives the text a neat appearance, but can lead to  
‘gappy’ lines, with much more horizontal spacing than others. 

It’s often better to align the text on the left only, as in this guide, 
especially if your paragraphs are generally short. 

You can specify your chosen alignment in the Paragraph 
dialogue box, as below. The ‘Left’ option will align the text on the 
left side only; ‘Justified’ will align it on both sides. 
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All of these settings are also available on the Home toolbar, just 
above the Paragraph label. 

When you’ve decided on your paragraph settings, create a style 
(or modify an existing one) to define them, perhaps with an 
additional style for paragraphs that immediately follow headings, 
as mentioned earlier. 

Please also see the advice under ‘Page layout’. 

Headings 

Headings play a key role in helping the reader to find their way 
through the text. They clarify how the content is structured, and 
help guide the reader if they’re looking for something specific. 

If you’re using more than one level of headings, it’s especially 
important to make sure each level has a consistent format that’s 
clearly different from those of other levels. You can do this by 
using features such as: 

• font size 

• bold 

• italic 

• colours 

• use of capitals 

• having a line underneath (and possibly one above) 

• centred versus left-aligned 

• new page before the heading. 

Generally, the higher-level headings should have attributes that 
make them bigger or more striking than the lower-level ones. 
You don’t need to use many of these attributes, though: just one 
or two should be enough. 

Make sure each heading has a good degree of separation from 
the preceding text, and, usually, from the following text. In some 
cases, it might be suitable for a low-level heading to be very 
close to the text below it – but not if that text has multiple 
paragraphs with spacing between them. 

As well as helping to ensure consistency, the use of styles for 
your headings will allow you to create a list of them in the 
Navigation Pane (hit Ctrl + F and select the Headings tab; or go 
to the View toolbar and tick Navigation Pane), and to create a 
contents list by using the Table of Contents function. 

Lists 

These can be bulleted or numbered. The ‘numbered’ format 
might actually involve letters (upper or lower case) rather than 
actual numbers. Roman numerals (again, upper or lower case) 
are another option. 

As a general rule, numbers or letters are useful if the sequence 
of the listed items is especially important (for example, in a 
series of instructions) or if they’re referred to elsewhere. 
Otherwise, they would just be an unnecessary distraction, and 
it’s better to use bullets. 

Either way, make sure you use a consistent style, except where 
there’s a good reason to vary things – for example, if you’re 
using multi-level lists. 
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Always use: 

• the same type of bullet, or the same style of numbers or 
letters (including the decision on whether to use a full 
stop, a bracket or neither) 

• the same amount of indentation, both before and after the 
bullet, number or letter 

• the same spacing above and below items. 

Word has a pre-defined style called List Paragraph. By default, 
this is automatically applied when you use one of the list 

functions. If you’d rather use the Normal style, go to Options → 

Advanced and tick ‘Use Normal style for bulleted or normal lists’. 
Or you can create your own style for lists, and apply it manually 
after creating each list. 

Captions and table headings 

If you’re going to include things such as pictures or diagrams, it 
usually makes sense to label them (so that the main text can 
refer to them clearly) and write captions for them (so they will 
mean something to the reader). 

Make sure these captions look different from your normal text. 
You might choose to centre them (using the Alignment function 
in the Paragraph dialogue box), also making sure they’re 
indented further from the margin than the main text is. 

Similarly, you might want to use headings for tables, also with a 
distinctive format. 

Footnotes, endnotes and references 

Footnotes and endnotes also should look reasonably different 
from normal text, so that the reader can instantly see what they 
are. 

For references or bibliography entries, it usually makes sense to 
use a special type of paragraph layout. For example, you might 
choose to indent all lines except for the first one (which is the 
opposite of a normal indented paragraph format), so that the 
author’s name will stand out as the reader scans the list. Or you 
could use spacing to clearly separate the entries, with no 
indentation at all. 

Displayed quotations 

If you want a quotation to stand out from the rest of the text, or if 
it’s long and you think some separation would be useful, you can 
display it by putting it into a separate paragraph with distinctive 
formatting. 

As with captions, this might mean using extra indentation on 
both the left and right – although centred alignment is best 
avoided. 
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Other things to consider 

Page layout 

The default type of orientation, portrait layout, might seem like 
the obvious choice. But if your content is more likely to be read 
on a computer screen than on paper, landscape layout will help 
your readers to see more of it at a time, with less scrolling 
needed. 

Also, especially if you use landscape orientation, consider 
splitting the text into columns – as I’ve done in this guide – so 
that the reader won’t have to keep scanning all the way across 
the screen. 

To control these features of the document – or of just a part of it 
– select the Layout tab at the top of the screen, and you’ll then 
find the Orientation and Columns options: 

         

If you apply these settings to just a selected part of your 
document, Word will automatically divide it into sections, each 
with its own page layout details. 

Page headings and footers 

Although your document might mean a lot to you, and you might 
have slaved away at it over many hours, for your reader it may 
well be just one of many things they will read that day.  

To help them remember what it is and where it came from, 
consider using a page header, with its title and something to 
identify who has provided it. 

A page footer can be useful as well, especially if it includes the 
page number. You might also think of other small items of 
information that are worth including in the header or footer. 

To fill in the header and/or footer, choose the Insert tab (even if 
you’re actually going to change what’s already there, rather than 
inserting a header or footer). The Header and Footer functions 
will then appear in the toolbar. If you select one of these, the 
header or footer  become editable. 

To add a page number to the header or footer, use the Page 
Number function on the Insert toolbar. You can add other 
variable items, such as the file name, by using the Quick Parts 
function – also on the Insert toolbar – and then selecting Field 
from the drop-down menu. 
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Using templates 

If you’re likely to create a number of documents in the same 
style, consider setting up a template that defines your styles and 
page layout settings. 

A Word template is a type of file – Microsoft Word Macro-
Enabled Template (with the suffix ‘.dotm’) – that exists only for 
the purpose of creating documents with pre-defined features 
such as these. 

If you ‘open’ a template file, the document that you’ll then see in 
Word isn’t the template itself: it’s a Word document that has 
been created automatically, with the same settings and styles as 
the template. 

If you change any of these details in the new document and 
want to apply these changes to the template, there are two ways 
to do this: 

• For styles only: after changing the style details in the 
Modify Style dialogue box, tick the ‘New documents 
based on this template’ option. 

• Use the Save As function. In the Save as type drop-down 
list, choose ‘Word Macro-Enabled Template’. Navigate to 
the location of the existing template, select it, and choose 
the option of replacing it when prompted. 

As an alternative to using templates, you could create a new 
document by simply ‘cloning’ an existing one that has the styles 
and settings you need, and then changing the content as 
required. 



Tips for formatting your Word documents               GH Editorial 
 

11 

Wrapping up 

I hope you’re now convinced that taking good care of formatting 
– and especially using Word styles – will help you to produce 
documents that are more professional, consistent, readable, and 
useful to your target readers. 

I also hope you’ll agree that the extra effort is worth it in the end. 
It will need some work up-front, but that might well be offset by 
the time that will be saved later on, at stages when you and/or 
your editor might otherwise face the daunting, frustrating task of 
making sure everything is formatted and laid out in a sensible 
way. 

Key points 

• Always use styles – for ease, efficiency and 
consistency. 

• Help your readers by using distinctive formats for 
different elements of the text, especially for different 
heading levels. 

• Think about paragraph format and page layout – what 
will work best for your readers? 

• For consistency across a set of documents, create a 
template with all the styles and settings you want to 
use. 

This, though, isn’t a comprehensive guide to formatting in Word. 
There are many more tools, tricks and good practices that you 
can learn about, and many more types of formatting that you 
may need to deal with. A few useful online resources are listed 
on the next page. Happy hunting … 



Tips for formatting your Word documents               GH Editorial 
 

12 

Further reading 

• Microsoft: Word help center  

o ‘Format text’  

o ‘Lay out pages’  

• LibroEditing (Liz Dexter): ‘Resources for Word (and other Microsoft Office software) users’  

• Louise Harnby: ‘Formatting your book in Word: How to save time with the Styles tool’ 

 

https://support.office.com/en-us/word
https://support.office.com/en-us/article/format-text-6f439b67-cf21-4dd5-9397-76256905fbc6?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/lay-out-pages-8f25ddae-4a8d-4439-a25d-04a694b1a930?ui=en-US&rs=en-US&ad=US
https://libroediting.com/blog/students-small-businesses-word-users/#wrd
https://www.louiseharnbyproofreader.com/blog/category/using%20word
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GH Editorial is a service run by Graham Hughes, an editor and 
proofreader with a background in information technology. 

Graham can work with many types of written material, but 
specialises in business content and non-fiction books. 

To learn more about Graham and how he can help you, please 
visit the GH Editorial website at www.gh-ed.com or his 
Chartered Institute of Editing and Proofreading directory entry at 
www.ciep.uk/directory/graham-hughes. 

Email – graham@gh-ed.com  

LinkedIn – www.linkedin.com/in/graham-hughes/  

Twitter – www.twitter.com/GHughesEd  
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